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1 Введение

На сегодняшний день, во множестве отраслей человеческой деятельности, в системах автоматики, в различных системах обработки сигналов и информации находят своё применение электронные устройства, в состав которых, входят программируемые микроконтроллеры (МК).


МК образуют особую группу микропроцессорных систем с программным управлением и представляют собой микроЭВМ с хранимым в постоянной памяти прикладным программным обеспечением. Таким образом, для МК характерен программно-аппаратный принцип организации, который заключается в том, что реализация целевого назначения МК достигается не только аппаратными средствами, но и с помощью программного обеспечения. Это обеспечивает ряд достоинств применения МК (лёгкая корректировка параметров устройства без изменения схемы, функциональная гибкость, надёжность вследствие применения интегральных элементов, дешевизна).


Для выполнения своих функций в устройстве МК предварительно должен быть соответствующим образом запрограммирован. Это возможно сделать при помощи специальных средств отладки микропроцессорных систем (МС), которые как правило включают в себя как аппаратную (программаторы, внутрисхемные отладчики и прочее) часть, так и часть программную (программы-отладчики, компиляторы, ассемблеры и прочее). Обе части взаимодействуют и дополняют друг друга.


В связи с бурным развитием электронной промышленности во всём мире, на рынке электронных компонентов на смену морально устаревшим МК всё чаще приходят новые, как правило, с более высокими техническими и функциональными характеристиками, и требующие более новых средств создания и отладки их программного обеспечения.


Знание и умелое использование современных средств отладки МС позволяют разработчику значительно сократить время и финансовые затраты и на освоение нового типа МК, и на разработку устройств со сложными алгоритмами работы. Здесь стоит отметить, что в условиях современных рыночных отношений важным фактором успешного развития предприятия является быстрота реагирования на новые достижения в соответствующей области производства (быстрота и качество освоения новых ресурсов). В таких условиях к разработчику предъявляются высокие требования, которым он должен в полной мере соответствовать.


Данные лабораторные работы направлены на освоение версии 7.10 интегрированной среды проектирования MPLAB IDE, как универсального средства для создания и отладки программного обеспечения для PIC-микроконтроллеров, а также на изучение принципов разработки устройств на МК. Для этого необходимо:


- наличие описания среды проектирования MPLAB IDE (с примером);

- наличие описания языков проектирования (ассемблер, «С»);


- создание ряда обучающих программ-примеров с анализом и пояснениями;

2  Интегрированная среда проектирования MPLAB IDE

MPLAB IDE – это бесплатная, легкая в освоении и использовании интегрированная среда разработки программного обеспечения микроконтроллеров PICmicro, работающая под управлением операционной системы Windows. MPLAB включает в себя текстовый редактор, симулятор (виртуальный отладчик MPLAB SIM), менеджер проектов и поддерживает работу внутрисхемных эмуляторов (MPLAB ICE 2000, MPLAB ICE 4000), внутрисхемного отладчика (MPLAB ICD 2), программаторов (PICSTART Plus, PRO MATE II, MPLAB PM3, PICkit 1), и других отладочных средств и инструментов фирмы Microchip и прочих фирм.


Инструментальные средства MPLAB, позволяют разработчику:


- получить исходный код программы, листинг программы;


- наблюдать выполнение программы с помощью симулятора, или в реальном
времени, используя эмулятор (требуется аппаратная часть);


- определять время выполнения программы;


- просматривать текущее значение переменных и специальных регистров;


- использовать возможность пошагового выполнения программы и систему

точек остановки, трассировки, сложных условий, для быстрой и удобной отладки программы.

- работать с программаторами PICSTART Plus и PRO MATE II;

- эффективно использовать систему помощи по MPLAB IDE

MPLAB IDE обеспечивает разнообразные средства симуляции и эмуляции исполняемого кода для выявления логических ошибок.

Графический интерфейс рабочего стола среды проектирования представлен на рисунке 2.1 

где:
1 – главное текстовое меню; 2 – графическое меню; 3 – окно, отображающее структуру (файловое дерево) проекта; 4 – окно, содержащее информацию о результатах работы MPLAB IDE; 5 – рабочая область, в которой размещаются открытые окна с файлами, диалогами или другой информацией; 6 – линейка состояния, отображающая текущую настройку системы.
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2.1 Начало работы в MPLAB IDE (с примером)


2.1.1 Создание нового проекта. Для работы симулятора MPLAB SIM нужен код программы (исполняемый файл с расширением .hex), который получается компиляцией исходного текста программы, содержащегося в файле с расширением .asm, включённого в проект с соответствующим названием. Проект в MPLAB IDE, в общем случае, может включать в себя несколько файлов с текстом исходной программы, при компиляции же проекта будет сформирован один hex-файл. Таким образом, проект объединяет все файлы, входящие в него, в том числе, файлы, необходимые для правильной компиляции текста программы.
В данном примере hex-файл будет называться proba.hex, позже он может быть загружен непосредственно в микроконтроллер с помощью программатора.


Среда MPLAB IDE позволяет создать новый проект двумя различными способами:


1. Через менеджер проектов «Project Wizard», запускаемый через пункт главного текстового меню Project >Project Wizard….

2. Через пункт меню Project >New… 


На мой взгляд, первый способ более эффективный, так как предполагает пошаговое создание проекта с выбором соответствующего типа МК, настройкой языковых параметров проекта и включением в него необходимых файлов.


Для создания проекта через «Project Wizard» выберите в главном текстовом меню пункт Project >Project Wizard…, в появившемся окне приветствия «Welcome!» нужно нажать кнопку «Далее», появится окно первого шага «Select a device» изображенное на рисунке 2.2, где нужно выбрать тип МК, для которого будет создаваться программа (PIC16F877). После выбора типа МК нажмите кнопку «Далее».
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В окне второго шага «Select a language toolsuite» (рисунок 2.3) выбирается вид языка (средства) программирования для ведения проекта. Для принятия выбранного Вами средства программирования нажмите кнопку «Далее».
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В окне третьего шага «Name your project» (рисунок 2.4) в области «Project Name» укажите имя создаваемого проекта, например «proba» и путь к директории будущего проекта в области «Project Directory», как это сделано в данном примере (каждый новый проект желательно располагать в отдельной директории, выбрать или создать которую можно в окне обзора папок, вызываемого нажатием кнопки «Browse…»). Нажмите кнопку «Далее».
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В окне четвёртого шага «Add any existing files to your project» (рисунок 2.5) предоставляется возможность включения в проект некоторых файлов (например INC-файлов заголовков или уже созданных ASM-файлов с текстом исходной программы).

 Для этого, выбрав соответствующие файлы в левом окне, кликнуть «ADD» или дважды кликнуть на выбранном файле, имена выбранных файлов появятся в правом окне. Если Вам необходимо чтобы выбранные файлы были скопированы непосредственно в  директорию создаваемого проекта, поставьте напротив соответствующих имён файлов галочки. Если файлы ещё не созданы или включать, как вам кажется, просто нечего (можно включить и потом), то этот шаг можно пропустить, сразу нажав кнопку «Далее».

      
[image: image5]

По причине того, что четвёртый шаг оказался последним, после нажатия кнопки «Далее» появляется окно отчёта «Summary», содержащее краткий отчёт о параметрах создаваемого проекта: тип МК, средство программирования, имя файла проекта с указанием полного пути к нему, а также, сообщение о создании нового рабочего пространства и добавлении в него проекта. Здесь, если всё вас устраивает, можно нажать кнопку «Готово». При этом в окне структуры проекта в вершине файлового дерева появится файл proba.mcp (проект готов).

И теперь, как нельзя  к стати следует перейти настройкам среды проектирования, которые предполагают следующее:


- выбор типа используемого микроконтроллера;


- настройку битов конфигурации выбранного микроконтроллера;


- выбор и настройку отладчика кода программы;


- настройку языковых средств программирования (если необходимо).
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2.1.2 Выбор типа микроконтроллера. Выберите в главном текстовом меню пункт Configure>Select Device…, в появившемся диалоговом окне «Select Device», изображённом на рисунке 2.6, выберите из разворачивающегося списка микроконтроллер «PIC16F877» и подтвердите выбор нажатием клавиши «OK».

Цвет индикаторов символизирует совместимость соответствующего инструмента данному типу МК.

Зелёный – тип МК полностью поддерживается.

Жёлтый – тип МК поддерживается частично.

Красный – тип МК не поддерживается.

2.1.2.1 Настройка битов конфигурации.[image: image29.png][\ MPLAB IDE ¥7.10
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 Для этого выберите в главном текстовом меню пункт Configure>Configuration Bits…, появится окно «Configuration Bits» показанное на рисунке 2.7. Оно содержит следующие биты конфигурации:

Oscillator – бит выбора режима тактового генератора;
Watchdog Timer – бит режима работы сторожевого таймера;
Power Up Timer – бит разрешения/запрета работы таймера включения питания;

Brown Out Detect – бит разрешения/запрета сброса по снижению напряжения питания;
Low Voltage Program – бит разрешения/запрета низковольтного программирования;
Flash Program Write – бит разрешения/запрета записи во FLASH память программ;
Data EE Read Protect – бит защиты EEPROM памяти данных от чтения;
Code Protect – бит защиты памяти программ от чтения.

В обще говоря, набор битов конфигурации может быть различен для разных типов МК даже в пределах одного семейства и обуславливается их некоторыми аппаратными особенностями.

По умолчанию Сторожевой таймер включён, то есть, в ходе выполнения программы его необходимо будет периодически сбрасывать, иначе произойдёт отключение МК. Для того чтобы этого не делать, достаточно отключить сторожевой таймер, как это сделано на рисунке 2.7. Сторожевой таймер необходим для отключения МК в случае нештатной его работы.

2.1.3 Выбор средства отладки. Выберите в главном текстовом меню пункт Debugger>Select Tool>MPLAB SIM, после этого, в графическом меню команд появится панель управления следующего вида [image: image6.png]| MPLAB IDE v7.10 EETE
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2.1.3.1 Характеристики симулятора MPLAB SIM.
Настоящая работа построена с учётом использования ресурсов и возможностей только программного симулятора (MPLAB SIM), который является самым доступным средством отладки программного обеспечения микроконтроллеров, так как он интегрирован в среду MPLAB IDE, распространяется бесплатно и не требует каких-либо дополнительных аппаратных средств. Программный симулятор моделирует выполнение программы микроконтроллера с учётом состояния всех внутренних регистров и портов ввода/вывода микроконтроллера.

MPLAB SIM выполняет контроль и управление состоянием портов ввода/вывода на границах инструкций с периодичностью TCY. TCY – время выполнения одной инструкции равное 4 TOSC, где TOSC период тактового генератора микроконтроллера. Поэтому некоторые физические события не могут быть смоделированы точно:

- асинхронные сигналы (относительно тактового генератора

микроконтроллера);

- сигналы, которые имеют период меньше TCY.

Все внешние события синхронизируются к границам цикла команд микроконтроллера, поэтому событие длительностью меньше одного машинного цикла смоделировано быть не может. По этой причине, следующие ограничения распространяются на симуляцию портов ввода/вывода и периферийных модулей PICmicro:

- тактовые импульсы таймеров не могут быть меньше времени TCY, хотя предделитель способен обрабатывать импульсы короче времени выполнения одной инструкции;

- ШИМ импульсы меньше TCY не поддерживаются;

- не поддерживается 8-разрядное сравнение;

- асинхронные сигналы (относительно тактового генератора

  микроконтроллера) не моделируются;

- форму сигнала генератора на выводах RC0/RC1 описывать нельзя;

- MPLAB SIM не моделирует работу последовательных интерфейсов.

Так, исходя из характеристик симулятора MPLAB SIM, накладываются некоторые ограничения на использование симулятора при отладке программ:

-невозможность отладки программы с реальными входными сигналами на

выводах  микроконтроллера;

- невозможность запускать выполнение программы в реальном времени.
Тем не менее, на практике MPLAB SIM используется для нахождения и исправления большинства ошибок в программе и является наиболее подходящим инструментом для оптимизации алгоритмов. В отличие от некоторых эмуляторов, симулятор MPLAB SIM позволяет контролировать все внутренние регистры микроконтроллера. MPLAB SIM может использоваться для полной отладки программы, если разработчик не сталкивается с необходимостью обработки состояний портов ввода/вывода или работы с периферийными модулями в реальном масштабе времени.

2.1.3.2 Настройка программного отладчика. Для настройки параметров отладчика выберите в главном текстовом меню пункт Debagger>Settings…, на экране появится окно «Simulator Settings», изображённое на рисунках 2.8 а и 2.8 б.

[image: image7]
Окно включает в себя раскладки:

Osc/Trace – раскладка настроек частоты тактового генератора моделируемого МК и опций моделирования трассировки; Break Options – раскладка настроек моделирования прерываний от всех возможных источников; SCL Options – раскладка настроек моделирования SCL-генератора, используемого для организации функций синхронного стимула; Uart1 IO – раскладка настроек моделирования последовательного интерфейса ввода/вывода; Animation/Realtime Updates – раскладка настроек временных параметров режима анимации и периода обновления окна системного таймера «Watch»; Limitations – информация об ограничениях, накладываемых на моделирование функций выбранного МК.

Раскладка «Osc/Trace» включает в себя поле «Processor Frequency», в котором можно задать значение частоты тактового генератора моделируемого МК. Справа, в поле «Units» указывается размерность введённой величины (Hz – герц, kHz – килогерц и MHz – мегагерц). В поле «Trace Options» можно разрешить или запретить трассировку, поставив или сняв флажок «Trace Enable». Здесь же можно разрешить или запретить прерывания от переполнения буфера трассировки ёмкостью в 32767 инструкций центрального процесса, установив или сняв флажок «Break on Trace Buffer Full».

Раскладка «Break Options» – Содержит два основных поля «Warnings» (предупреждения) и «Errors» (ошибки). В каждое из них входят окна представленные разворачивающимися списками:  «Core (including steck)» – запросы прерываний от ядра МК, включая стек; «Periferal» – запросы прерываний от периферийных модулей МК; «WDT Timeout» – запрос прерывания от сторожевого таймера. В каждом из этих окон из списка нужно выбрать один из вариантов моделирования:


Break – перейти к обработке соответствующего прерывания;


Ignore – игнорировать запрос прерывания;


Report – выдать соответствующее предупреждение о запросе прерывания,

для «Core (including steck)» и
 «Periferal», и

Break – перейти к обработке соответствующего прерывания;


Break+Warn – перейти к обработке прерывания и выдать предупреждение;


Reset – перейти на вектор сброса (сброс МК),

для «WDT Timeout».


В окне «WDT Period» задаётся длительность периода сторожевого таймера в миллисекундах. Кнопка «Default» устанавливает значение периода равным по умолчанию 18 мс.


Выберете раскладки «Osc/Trace» и «Break Options» и задайте необходимую частоту генератора и опции моделирования прерываний в соответствии с рисунками 3.8 а и 3.8 б, кликните кнопку «OK» для принятия вновь установленных параметров.

2.1.4 Создание файла с исходным текстом программыи получение исполняемого кода программы. Теперь необходимо создать файл с исходным текстом программы. Это можно сделать через пункт меню File > New или кликнув клавишу графического меню [image: image8.png]© @ | Checksum: Dx1bif
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. В рабочей области MPLAB IDE появится окно текстового редактора в котором вводится текст исходной программы (файл с программой рекомендуется время от времени сохранять на жёсткий диск компьютера, поэтому, сначала необходимо через пункт меню File > Save As…сохранить имеющийся файл в директорию проекта, можно под именем текущего проекта). После того как файл был сохранён под соответствующим именем (рисунок 2.9 б), его нужно включить в проект, кликнув правой кнопкой мыши на заголовке Sourse Files в окне проекта и выбрав в появившемся меню команду Add Files, как показано на рисунке 2.9 а. Далее находим наш сохранённый файл с расширением .asm и двойным щелчком левой кнопки включаем его в проект. Включённый в проект файл появился в окне проекта под раскладкой Sourse Files (смотреть рисунок 2.9 с).

[image: image9]

Для получения исполняемого кода программы необходимо откомпилировать проект. Для этого, нужно выбрать пункт меню Project > Build All или кликнуть на графической панели клавишу [image: image10.png]


. Если в тексте программы нет ошибок, то в результате успешной компиляции будет создан hex-файл с исполняемым кодом программы и компилятор выдаст в окне «Output» сообщение о параметрах успешной компиляции исходного текста программы. А в некоторых случаях, кроме сообщений о параметрах компиляции, компилятор ещё может выдавать три типа информационных сообщений:

Error – сообщения о явных ошибках в исходном тексте программы (ошибки в синтаксисе команд).
Warning – сообщения-предупреждения о неявных ошибках в тексте программы, которые связаны в основном с нарушением правил языка программирования и могут явиться причиной ошибочной работы программы.

Message – сообщения, касающиеся учёта особенностей работы компилятора, например, о параметрах сохранения по умолчанию и т.д.

Все эти сообщения сопровождаются краткой информацией об ошибке или нарушении с указанием местоположения её в тексте исходной программы (для перехода к строке, содержащей ошибки достаточно лишь дважды кликнуть на соответствующей строке предупреждения). Следует отметить, что в случае ошибки файл с исполняемым кодом не сформируется, а в случае предупреждения он всё-таки будет сформирован, однако, результат работы программы может отличаться от ожидаемого.

Примеры окон с различными сообщениями компилятора приведены на рисунках 2.10 а и 2.10 б


[image: image11]

[image: image12]
2.1.5 Запуск и отладка программы. После того, как проект был успешно откомпилирован, программу можно запустить на выполнение (симуляцию), для этого сначала нужно выбрать в качестве отладчика программный эмулятор «MPLAB SIM» через пункт текстового меню Debugger>Select Tool>MPLAB SIM, если этого не было сделано ранее. Далее через соответствующий пункт командного меню или через кнопки графического меню, можно запустить программу на выполнение в одном из предложенных режимов:

Debugger > Run, F9 или [image: image13.png]


 (запуск программы) – запускает программу на выполнение. Программа выполняется до тех пор, пока не будет удовлетворено одно из условий остановки. Выполнение программы начинается с текущего значения счетчика команд, отображаемого в линейке состояния. Текущее значение счетчика команд также указывается в окне памяти программ. Во время выполнения программы кнопки Step Into и Run заблокированы.

Debugger >Animate или [image: image14.png]


 (запустить программу в режиме анимации) – симулятор работает непрерывно, обновляя значение регистров после выполнения каждой инструкции программы. Выполнение программы в режиме анимации значительно медленнее, чем по команде Debug > Run, но позволяет визуально контролировать состояние регистров микроконтроллера и значения секундомера.

Debugger >Step Into, F7 или [image: image15.png]


 (выполнить одну инструкцию программы) – по этой команде выполняется одна инструкция микроконтроллера (одна или несколько инструкций цикла), а затем программа останавливается, обновляя значение регистров. Во время работы в «режиме реального времени» кнопка Step Into игнорируется.

Debugger >Step Over, F8 или [image: image16.png]


 (выполнить одну инструкцию программы) – выполнить текущую инструкцию программы. По команде Step Over инструкции CALL выполняются за один шаг (полностью выполнив подпрограмму). Затем выполнение программы останавливается в следующем за инструкцией CALL адресе.

Debugger >Step Out, или [image: image17.png]


 – По команде Step Out за один шаг выполняются все следующие инструкции текущей подпрограммы и происходит возврат из неё с обновлением значений регистров (команда работает только в теле подпрограммы).
Debugger >Reset >Processor Reset, F6 или [image: image18.png]


 – сброс микроконтроллера, аналогично сбросу по сигналу -MCLR (в счетчик команд записывается адрес вектора сброса). Если во время сброса программа исполнялась, то она продолжит выполняться с адреса вектора сброса.

Debugger >Halt, F5 или [image: image19.png]


 (остановить) – остановить ход выполнения программы (счетчик команд остановлен). Информация о состоянии микроконтроллера будет обновлена.
2.1.6 Использование окон с переменными. MPLAB IDE позволяет наблюдать за содержимым регистров в отдельном окне. Чтобы создать окно, выберите пункт меню View >8 Watch. На экране появится  окно «Watch», вид его представлен на рисунке 2.11. В верхней части окна представлены два разворачивающихся списка: с именами регистров специального назначения справа и символьными обозначениями регистров слева. Там же перед каждым из списков имеется соответствующая клавиша: «Add SFR» (добавить регистр специального назначения) и «Add Symbol» (добавить символ) соответственно. Например, чтобы в создаваемое окно включить переменную с именем «c1», необходимо выбрать «c1» в списке символов и нажать

клавишу «Add Symbol», после чего переменная (её адрес, символ и величина) отобразятся в таблице окна. 



[image: image20]

Также переменные можно включить в окно, дважды кликнув в свободной области «Symbol Name» (символьное имя) после чего, указав нужное имя кликнуть в [image: image30.png][\ MPLAB IDE ¥7.10
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любое место поля окна. И переменная в таблице.

Правым щелчком мыши на поле окна можно вызвать системное меню окна (смотреть рисунок 2.11).


Чтобы окном с переменными было удобно пользоваться, его можно настроить, добравшись до его свойств через пункт системного меню окна «Propierties…». В появившемся одноимённом окне «Watch», приведённом на рисунке 2.12, на раскладке «Watch Properties» представлены окна с разворачивающимися списками, необходимые для настроек отображения величин переменных в окне: Simbol – имя текущей переменной; Size – разрядность текущей переменной; Format – формат текущей переменной Byte Order – отображение или выбор последовательности байтов (старший/младший); Memory – отображение типа памяти для текущей переменной.

На раскладке «Preferences» представлены настройки связанные с выбором типа формата с плавающей точкой (floating-point format). Тип формата здесь определяется особенностями используемого компилятора. Также представлены настройки связанные с выбором типа формата если информация о нём в COD-  COFF-файлах отладчика отсутствует.


Раскладка «General» содержит настройки связанные с выбором шрифтов и цветовой гаммы окна «Watch».
2.1.7 Точки остановки (Breakpoints).[image: image31.png]s MPLAB IDE v7.10 =10/
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 Точка остановки – условие, при котором микроконтроллер прекращает выполнение программы. Точки остановки в MPLAB IDE являются одним из средств контроля за ходом выполнения программы. При совпадении адреса точки остановки со значением счетчика команд PC, MPLAB прерывает ход выполнения программы на инструкции, адрес которой соответствует адресу точки остановки.

Для задания точки остановки в нужном месте программы достаточно дважды кликнуть на строке программы и в поле указателя счётчика команд напротив текущей строки появится соответствующий значок точки остановки [image: image21.png]Fle Edt View Projct Debugger Programmer Tools Corfigure Window Help
DSW| ' m@ | Sh e J O H B S J Checksum: 0x5058 | o 11 ob & O (7 B}
X

= probamep
£ Source Files
proba.asm
5 Header Files
PLEFE77.INC
Object Fils
Library Files
Linker Scrpts
Other Files

rogram Fi prob:

“plevs77 ine-

5R| [EDCOND =] _Add Symbal] | Torer?

3aaress Syubol ame Value
oazo ) £
o008 TCon oaooo000

i = =

weagsm | Picierar  pen  Wme  kdec [~ [ beko bng Gl s WR

Binye| (3 [ 3 Total Conmander 6.0...|

3 Mcrosoft wiord  +|[BMPLABIDE v7.10 (5 MPLAB IDE Help @, ¢ 1455




. Удалить точку, можно дважды кликнув на строке программы с данной точкой, значок исчезнет.


Также задать/удалить точки остановки и их параметры можно через пункт командного меню Debugger > Breakpoints… или нажав F2. В появившемся окне «Breakpoints» (смотреть рисунок 2.12) в области «Program Memory Breakpoints:» можно видеть список уже имеющихся в программе точек остановки, в области «Break at:» можно ввести адрес новой точки и нажать ввод, точка отобразится в общем списке.

В окне имеются функциональные кнопки:


«Remove» – удалить выбранные точки остановки;

«Remove All» – удалить все точки остановки;

«Enable All» – разрешить все точки остановки;

«Disable All» – запретить все точки остановки.


В окнах Active «Breakpoint Limit» и «Available Breakpoints» отображается общее количество точек остановки, возможное для данного отладчика, и количество уже установленных точек соответственно.

Для принятия изменений остаётся кликнуть кнопку «OK». Вновь созданная точка остановки будет помечена значком [image: image22.png]M MPLAB IDE v6.62
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.

В MPLAB IDE v7.10 в отличие от MPLAB IDE v5.xx отсутствуют две функции связанные с точками остановки: точки остановки по условию и задание числа проходов для точек остановки.
2.1.8 Определение времени выполнения кода программы. Для удобного определения времени выполнения микроконтроллером кода программы или какой-либо  части её, в MPLAB имеется так называемый системный секундомер, который считает число циклов и время работы микроконтроллера от последнего сброса.
Для вызова секундомера необходимо выбрать пункт меню Debugger > StopWatch. Окно секундомера показано на рисунке 3.13 включает в себя следующие [image: image32.png]Fie Edt Vew Project Debugger Programmer Tods Configre Window Help
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элементы:

StopWatch – раскладка показаний секундомера;

Total Simulated – раскладка общих текущих значений параметров;
Instruction Cycles – количество циклов;
Time (uSecs) – прошедшее время от последнего сброса (в микросекундах); Соответствует числу выполненных циклов.
Synch – синхронизация текущих показаний секундомера с текущими значениями общих параметров;
Zero – сброс значений раскладки показаний секундомера;
Processor Frequency (MHz) – текущее значение тактовой частоты микроконтроллера (в мегагерцах);
Clear Simulation Time on Reset – cброс значений секундомера при сбросе микроконтроллера.
2.1.9 Использование функций стимула. Довольно часто, при отладке программы, встаёт задача необходимости моделирования состояния портов ввода/вывода или записи определённого значения непосредственно в регистры МК. Возможность решения такой задачи предоставляется совместным использованием двух средств: Stimulus Controller и SCL Generator, подготавливающих сигналы стимулов для отладчика MPLAB SIM.


Существует два основных вида стимулов:


1. Асинхронный стимул – непосредственное управление состоянием портов ввода/вывода путём нажатия кнопки в соответствующем диалоговом окне стимула. Используется для моделирования логического состояния порта ввода/вывода настроенного на вход (установка значений +5В или 0В).


2. Синхронный стимул – регулярный, программируемый (наперёд заданный), периодический источник тактового сигнала. Синхронный стимул формирует на входе порта ввода/вывода регулярную форму сигнала с периодичностью кратной тактовым циклам микроконтроллера.


Для работы с асинхронными стимулами и файлами SCL-генератора, использующих язык управления симулятором (Simulator Control Language) используется инструмент Stimulus Controller. Он обеспечивает непосредственное использование подготовленного стимула отладчиком MPLAB SIM. Диалоговое окно этого инструмента можно запустить, выбрав пункт меню Debugger > Stimulus Controller > New Scenario. Диалоговое окно «Stimulus Controller», приведённое на рисунке 2.15, посредством нажатия кнопки «Save Scenario», позволяет сохранить текущую конфигурацию настроек в stc-файл сценария для быстрой загрузки этой конфигурации при повторном её использовании.


Окно «Stimulus Controller» включает в себя две области: «Stimulus (SCL) File» и «Asynchronous Stimulus».


В области «Stimulus (SCL) File» имеются функциональные клавиши:


Attach – подключить файл стимула (sti-, ssti-, psti-, fsti- или SCL-файл);

Detach – отключить подключенный файл стимула;

Import/Merge – объединить два SCL-файла в один.


Область «Asynchronous Stimulus» (асинхронный стимул) представлена таблицей включающей в себя поля:


Fire – содержит кнопки «>» активизирующие функции стимула заданные в текущей строке справа;

Pin – содержит названия стимулируемых выводов МК, которые выбираются из разворачивающегося списка;

Action – содержит непосредственно значение стимула (Set High – сигнал высокого уровня, Set Low – сигнал низкого уровня, Toggle – инвертированный сигнал, Puls Low – импульс сигнала низкого уровня, Puls High – импульс сигнала высокого уровня);


Width – содержит величину длительности импульса (если Action = Puls);

Units – содержит размерность величины длительности импульса (cyc – машинные циклы, ns – наносекунды, us – микросекунды, ms – миллисекунды, sec – секунды);

Comments – может содержать текстовые комментарии.


[image: image23]
2.1.10  Задание асинхронного стимула порта ввода/вывода. Для задания асинхронного стимула вывода порта необходимо через пункт командного меню Debugger > Stimulus Controller > New Scenario вызвать диалоговое окно «Stimulus Controller» и в строку таблицы «Asynchronous Stimulus» ввести необходимые параметры соответствующего стимула. Таким образом, каждая заполненная строка содержит отдельный асинхронный стимул. 

Чтобы удалить ненужный стимул нужно выделить соответствующую строку и нажать кнопку «Delete row» (удалить строку).


На рисунке 2.15, в таблице «Asynchronous Stimulus», приведён пример задания нескольких асинхронных стимулов для выводов RB0 и RB1.


Приведённый пример задания стимулов, нажатием кнопки «Save Scenario», можно сохранить в файл сценария, например под именем AsynchStim.stc. В дальнейшем его можно будет загружать через пункт меню Debugger > Stimulus Controller > Open Scenario с последующим выбором файла сценария.

Приведённый пример и все остальные, связанные с использованием функций стимула, можно повторить и проверить используя в качестве действующей программы программу проекта «proba». Наблюдать за уровнями сигналов на линиях портов и содержимым регистров можно в окне регистров специального назначения «Special Function Registers» или в окне с переменными «Watch».

2.2 Разработка обучающих программ на языке ассемблера

Для того, чтобы настоящая работа сполна соответствовала поставленной задаче автор разрабатывает несколько обучающих программ, ориентированных на возможность несложного их повторения, например, на лабораторных работах, посвящённых изучению микроконтроллеров.


Часть программ ориентирована на изучение аппаратных средств МК (системы прерываний, портов ввода/вывода, таймеров/счётчиков, памяти программ и памяти данных), другие программы направлены на изучение методов обработки данных (умножение, деление, маскирование). Также программы иллюстрируют сами правила написания программ на языке ассемблера MPASM для микроконтроллеров PICmicro (правильное использование некоторых директив и инструкций MPASM).


Всем приводимым далее программам предшествует краткое описание, поясняющее суть программы.

Программа 1 «Знакомство с MPLAB IDE». Программа 1 довольно проста, с неё и можно начать знакомство с работой в MPLAB. Данная программа иллюстрирует работу некоторых команд передачи управления (goto, decfsz), команд пересылки (movlw, movwf) и объясняет значения некоторых директив ассемблера (list, include, equ и org). В программе константе «с1» ставится в соответствие ячейка с адресом 0x20 в памяти данных, далее в «с1» помещается число 0x09. Затем, содержимое «с1»  уменьшается на 1 при каждом выполнении команды decfsz c1, F, при достижении нулевого значения «с1» снова перезагружается числом 0x09 и цикл повторяется. 
Справа от меток, директив и операторов через знак «;» приведены комментарии, поясняющие их назначение в текущей программе. 

;****
Программа
1********


list
p=16f877
; Директива «list» с параметром, определяющим тип МК

include <p16F877.inc>
; Подключение файла заголовка «p16F877.inc» 






; с помощью директивы «include»

c1
equ
0x20

; Определение константы «с1» по адресу 0x20






; в памяти данных (ПД)

org
0x0000
; Установка начала размещения кода программы в вектор




; сброса по адресу 0x0000 в памяти программ (ПП)
reset



; Метка «reset» (сброс)

goto
start

; Переход на метку «start»

org
0x0005
; Установка следующей команды по адресу 0x0005 в ПП
start



; Метка «start» (начало)

movlw 0x09

; Запись числа 0x09 в регистр аккумулятора «WREG»

movwf c1

; Запись в регистр «с1» содержимого «WREG» (число 0x09)
loop



; Метка «loop» (зациклить)

decfsz c1, F

; Декрементировать содержимое «c1», результат поместить 




; в «c1», пропустить следующую команду, если результат 




; нулевой

goto loop

; Переход на метку «loop» (продолжить декрементирование)

goto start

; Переход на метку «start» (повторить всё заново)

end


; Конец программы


Легко заметить, что на основе команд условного перехода (например, decfsz) можно организовать счётчик проходов с заданным или вычисляемым числом проходов, что и сделано в программе 1 (цикл «loop» выполняется девять раз до очередной перезагрузки «c1»).

Программа 2 «Косвенный способ адресации». Программа 2, иллюстрирует применение косвенного способа адресации для заполнения нескольких последовательных ячеек памяти данных некоторой константой. В программе в регистре «FSR» устанавливается начальный адрес ячейки памяти данных, в которую будет записана соответствующая константа при попытке записи её в регистр «INDF». Далее инициализируется счётчик с обратным отсчётом для задания требуемого количества заполняемых ячеек и задаётся значение записываемой константы. На каждом отсчёте адрес ячейки в «FSR» инкрементируется на единицу.
;****
Программа 2**********


list p=16f877
; Определение типа МК

include <p16f877.inc> ; Подключение файла-заголовка
c1 
equ 0x20 

; Определение константы «с1» по адресу 0x20 в ПД

org 0x0000 

; Установить начало программы в вектор сброса
reset


goto start 

; Переход на начало программы

org 0x0005 

; Установка следующей команды по адресу 0x0005 в ПП
start


movlw 0x40

; Запись в аккумулятор, а затем в регистр «FSR» адреса 

movwf FSR

; ячейки памяти, с которой начнётся запись констант в ПД

movlw 0x05

; Запись в аккумулятор, а затем в регистр «c1» числа, 

movwf c1

; определяющего количество записей в память (загрузка 




; счётчика)

bcf STATUS, IRP
; Очистка бита «IRP» в регистре «STATUS» (выбор нулевого 



; и первого банков регистров при косвенной адресации)
loop

movwf INDF
; Запись константы (числа 0x05) из аккумулятора по адресу, 



; указанному в «FSR»

incf FSR, F

; Инкрементировать адрес ячейки, в «FSR», результат 




; оставить в «FSR»

decfsz c1, F

; Декрементирование содержимого счётчика («c1») до нуля

goto loop

; Повторить цикл записи

goto start

; Перейти на метку «start» (зациклить программу)

end

Программа 3 «Исследование памяти программ».
Программа 3 иллюстрирует особенности связанные с переключением между страницами памяти программ. Эти особенности заключаются в том, что переключение страниц осуществляется только после выполнения команд передачи управления (call и goto), выполняющихся за два машинных цикла. Также, после возвращения из подпрограммы (после восстановления полного 13-разрядного адреса из стека), перед выполнением очередной команды перехода необходимо, чтобы старшие разряды счётчика команд в регистре «PCLATH» программным путём были верно установлены, так как они остаются прежними. Поэтому, если в программе 3 перед командой goto start исключить команду bcf PCLATH, 3, то переход осуществится в пределах первой страницы, что вызовет ошибку в работе программы.
;****
Программа
3*************


list p=16f877

; Определение типа МК

include <p16f877.inc>
; Подключение файла-заголовка
c1
equ 0x20


; Определение константы «с1» по адресу 0x20 в ПД

org 0x0000


; Установить начало программы в вектор сброса
reset

goto start

; Переход на начало программы


org 0x0500

; Установка следующей команды в памяти программ по 




; адресу 0x0500(адрес на странице «0» (0000h–07FFh))
start


bcf PCLATH, 4
; Выбрать 


bsf PCLATH, 3
; страницу «1» (0800h–0FFFh)

call SUB1      ; Переход на страницу 1 в момент вызова подпрограммы «SUB1»

movlw 0x00

; Запись в регистр «c1» ПД

movwf c1

; 


константы 0x00

bcf PCLATH, 3
; Выбрать страницу «0» (0000h–07FFh)

goto start

; Перейти на начало программы (0x0500)

org 0x0900

; Адрес размещения подпрограммы SUB1 в ПП 0x0900
SUB1


movlw 0x11

; Запись в регистр

movwf c1

; 
«c1» ПД константы 0x11

return


; Возврат на страницу «0» (0000h–07FFh)


end

Программа 4 «Использование портов ввода/вывода». 
Программа иллюстрирует работу с портами ввода/вывода МК и метод обработки  вводимых из порта данных по «маске». В программе осуществляется инициализация порта B. Сначала все его линии настраиваются на вывод данных, и осуществляется вывод в порт B числа 0xAA, затем его линии настраиваются на ввод данных и с выводов порта читаются данные до тех пор, пока на выводах не появится комбинация сигналов соответствующая значению 0x0A и программа начинается заново. При отладке программы, входные сигналы на выводах порта подготавливаются с помощью асинхронного стимула.
;****
Программа
4************


list
p=16f877

; Определение типа МК


include <p16f877.inc>
; Подключение файла-заголовка
c1
equ
0x20


; Определение константы «с1» по адресу 0x20 в ПД

org
0x0000

; Установить начало программы в вектор сброса
reset

goto
start

org
0x0005
; Установка следующей команды по адресу 0x0005 в ПП
start

movlw
0xAA

; Запись константы 0xAA 


movwf
c1

; в регистр «c1»

 

; Инициализация порта В

bsf
STATUS,RP0

; Выбор первого банка регистров ПД

movlw
B'00000000'

; Конфигурирование всех линий порта B в 

movwf
TRISB 

; режим вывода данных (TRISB=0x00)

bcf
STATUS,RP0

; Выбор нулевого банка регистров ПД


; Вывод данных в порт

movf
c1, W


; Вывод содержимого регистра «c1» (0xAA)

movwf
PORTB
; в порт B


; Инициализация порта В

bsf
STATUS,RP0

; Выбор первого банка регистров ПД

movlw
B'11111111'

; Конфигурирование всех линий порта B в

movwf
TRISB

; режим ввода данных


bcf
OPTION_REG,NOT_RBPU
; Подключение внутренних 









; подтягивающих резисторов

bcf
STATUS,RP0

; Выбор нулевого банка регистров ПД


; Чтение данных из порта с последующей их проверкой


; на соответствие значению 0xAA
loop

movf
PORTB, W

; Чтение данных с линий порта B в регистр «WREG»


addlw
-0x0A

; Сложение числа –0xAA и содержимого «WREG»

btfss
STATUS,Z

; Проверка нулевого результата операции сложения

goto
loop


; Повторить чтение из порта B (PORTB не = 0x0A)


goto
start


; Переход на начало программы (PORTB=0x0A)

end

Программа 5 «Запись/чтение EEPROM-памяти данных».
Программа иллюстрирует порядок выполнения операций необходимых для осуществления записи информации в EEPROM-память и чтения информации из неё. В в переменной «E_Data» хранятся  данные, подлежащие записи в EEPROM-память, в переменной «E_Adr» хранятся данные, указывающие адрес ячейки EEPROM-памяти в которую будут записаны или из которой будут прочитаны данные. Из программы видно, что обращение к EEPROM-памяти осуществляется косвенно  через регистры EEDATA и EEADR.
;****
Программа 5************


list p=16f877

; Определение типа МК

include <p16f877.inc>
; Подключение файла-заголовка
E_Data
equ
0x70
; Константа, содержащая число для записи в EEPROM ПД
E_Adr
equ
0x71
; Константа, содержащая адрес ячейки в EEPROM ПД

org
0x0000
; Установить начало программы в вектор сброса

reset


goto
start

; Переход на начало программы


org
0x0005
; указать начало размещения программы в памяти программ

;********************************************************************


; Подпрограмма записи данных в EEPROM ПД
EE_WR

bsf STATUS, RP1

; Выбор третьего 


bsf STATUS, RP0

; 
банка регистров ПД

btfsc
EECON1, WR
; Проверка завершения

goto
$-1


; 
операции записи в EEPROM ПД

bcf STATUS, RP0

; Выбор второго банка регистров ПД

movf 
0x171, W

; Чтение адреса ячейки EEPROM в регистр 

movwf
EEADR
; 
адреса EEPROM «EEADR»

movf 
0x170, W

; Чтение данных для записи в EEPROM в 

movwf
EEDATA
; 
регистр данных EEPROM «EEDATA»

bsf STATUS, RP0

; Выбор третьего банка регистров ПД

bcf
EECON1, EEPGD

; Выбор EEPROM ПД

bsf
EECON1, WREN
; Разрешение записи в EEPROM ПД

bcf
INTCON, GIE
; Запрет системы прерываний



; Для предотвращение случайной записи

movlw
0x55

; Запись числа 0x55 в 


movwf
EECON2
; 

регистр EECON2


movlw
0xAA

; Запись числа 0xAA в 


movwf
EECON2
; 

регистр EECON2


bsf
EECON1, WR
; Инициализация непосредственно записи в EEPROM


bsf
INTCON, GIE
; Разрешение системы прерываний

bcf
EECON1, WREN
; Запрет записи в EEPROM ПД

return

; Возврат из подпрограммы
;********************************************************************


; Подпрограмма чтения данных из EEPROM ПД
EE_RD

bsf STATUS, RP1
; Выбор третьего

bsf STATUS, RP0
; 
банка регистров ПД

btfsc
EECON1,WR
; Проверка завершения


goto
$-1


; 
операции записи в EEPROM ПД

bcf
STATUS, RP0
; Выбор второго банка регистров ПД

movf 
0x171, W

; Чтение адреса ячейки EEPROM в регистр

movwf
EEADR
; 
адреса EEPROM «EEADR»

bsf STATUS, RP0

; Выбор третьего банка регистров ПД

BCF
EECON1, EEPGD

; Выбор EEPROM ПД

BSF
EECON1, RD
; Инициализация чтения EEPROM

bcf STATUS, RP0

; Выбор второго банка регистров ПД

movf
EEDATA, W
; Запись результатов чтения в аккумулятор «WREG»

return

; ; Возврат из подпрограммы
;********************************************************************

;
Основная программа.

start



movlw
0xAA

; Загрузка данных, в регистр «E_Data»

movwf
E_Data
; 
для последующей записи в EEPROM ПД

movlw
0x10

; Загрузка адреса ячейки EEPROM памяти

movwf
E_Adr
; 
в которую будут записаны данные

call
EE_WR

; Вызов подпрограммы записи данных в EEPROM ПД

bcf
STATUS,RP1
; Выбор нулевого 

bcf
STATUS,RP0
; 
банка регистров ПД

movlw
0x10

; Загрузка адреса ячейки EEPROM памяти

movwf
E_Adr
; 
из которой будут прочитаны данные

call
EE_RD

; Вызов подпрограммы чтения данных из EEPROM ПД

goto
$


; Зацикливание на месте

end

; Конец программы

Программа 6 «Исследование системы прерываний».
Программа иллюстрирует процесс настройки и работу аппаратной системы прерываний МК PIC16F877. В программе обрабатываются три источника запросов прерывания: линия внешнего запроса прерывания «INT», линии порта «B» RB4–RB7 и таймер/счётчик «TMR0» после обслуживания запросов которых, в «C1» будет записано соответствующее значение (0x01, 0x02 или 0x03 соответственно) Прежде чем перейти к обслуживанию какого-либо прерывания, предварительно сохраняется контекст основной программы. Команды рабочего цикла программы находятся на первой странице памяти программ (0x0800–0x0FFF) подпрограммы же обслуживания прерываний находятся в пределах нулевой страницы (0x0000–0x07FF), это сделано для того, чтобы реально показать в действии аппарат сохранения/восстановления контекста основной программы и его надобность для правильной работы программы. При отладке программы, сигналы на выводах портов подготавливаются при помощи асинхронного стимула.
;****
Программа 6********************


list

p=16f877

; Определение типа МК

include 
<p16f877.inc>
; Подключение файла-заголовка
C1


equ
0x20

; Определение необходимых
W_copy

equ
0x21

; констант
STATUS_copy
equ
0x22

; в адресном пространстве
FSR_copy

equ
0x23

; регистров 
PCLATH_copy
equ
0x24

; общего 
N


equ
0x25

; назначения


org
0x0000

; Установить начало программы в вектор сброса
reset


goto
START

; Перейти на начало основной программы
;************************************************



org
0x0004

; Установка следующей команды в памяти 






; программ по адресу 0x0004

; Сохранение контекста основной программы:


movwf
W_copy
; Сохранение текущего значения аккумулятора


movf
STATUS, W
; Сохранение текущего значения регистра 


movwf
STATUS_copy
; «STATUS» в «STATUS_copy»



movf
PCLATH, W
; Сохранение текущего значения регистра


movwf
PCLATH_copy
; «PCLATH» в «PCLATH_copy»



movf
FSR, W

; Сохранение текущего значения 



movwf
FSR_copy
; регистра «FSR» в «FSR_copy»



clrf
PCLATH

; Выбор нулевой страницы памяти программ
;************************************************


; Определение источника запроса прерывания по флагам запросов прерываний 
; и переход к соответствующей подпрограмме обслуживания


btfsc
INTCON,INTF
; Проверка флага внешнего запроса прерывания 

goto
INT_VNESH
; переход к подпрограмме обслуживания


btfsc
INTCON,RBIF
; Проверка флага запроса прерывания от линий 






; порта «B» (RB4–RB7)



goto
RB_VNESH
; переход к подпрограмме обслуживания


btfsc
INTCON,T0IF
; Проверка флага запроса прерывания от 







; таймера/счётчика «TMR0»


goto
TMR0_VNESH
; переход к подпрограмме обслуживания
;************************************************


; Подпрограмма обслуживания внешнего прерывания по линии «INT»

INT_VNESH   



bcf
INTCON,INTF
; Очистка флага запроса прерывания «INTF»


movlw
0x01

; Запись числа 0x01



movwf
C1

; в «C1»



goto
RESTORE_KON
; Вызов подпрограммы восстанавливающей 






; контекст основной программы
;************************************************


; Подпрограмма обслуживания прерывания от линий порта «B» (RB4–RB7)

RB_VNESH



bcf
INTCON,RBIF
; Очистка флага запроса прерывания «RBIF»


movf
PORTB, F

; Чтение изменённой информации в порт для 






; исключения противоречия


movlw
0x02

; Запись числа 0x01


movwf
C1

; в «C1»



goto
RESTORE_KON
; Восстановление контекста основной программы
;************************************************


; Подпрограмма обслуживания прерывания от таймера/счётчика «TMR0»

TMR0_VNESH


bcf
INTCON,T0IF
; Очистка флага запроса прерывания «T0IF»


movlw
0x03

; Запись числа 0x01


movwf
C1

; в «C1»



movlw
0xFA

; Перезагрузка таймера/счётчика «TMR0» 


movwf
TMR0
; числом 0xFA


goto
RESTORE_KON
; Восстановление контекста основной программы
;************************************************


; Подпрограмма восстановления контекста основной программы

RESTORE_KON


movf
FSR_copy, W
; Восстановление содержимого


movwf
FSR

; регистра «FSR»


movf
PCLATH_copy, W
; Восстановление содержимого


movwf
PCLATH

; регистра «PCLATH»



movf
STATUS_copy, W
; Восстановление содержимого


movwf
STATUS

; регистра «STATUS»



swapf
W_copy, F


; Восстановление содержимого


swapf
W_copy, W


; аккумулятора «WREG»



retfie


; Возврат с разрешением системы прерываний
;************************************************


; Основная программа (код её располагается в нулевой


; и первой страницах памяти программ.)

START

; Настройка режимов работы портов, таймеров/счётчиков


; и системы прерываний микроконтроллера.



bsf
STATUS,RP0

; Выбор первого банка регистров ПД


movlw
B'010000'
; Настройка линии порта RA4 на ввод даных, 


movwf
TRISA
; остальных – на вывод


movlw
B'11110001'

; Настройка линии порта RB0, RB4–RB7 на 


movwf
TRISB

; ввод данных, остальных – на вывод


movlw
B'11101000'

; Запись управляющего слова в 



movfw
OPTION_REG
; «OPTION_REG» для настройки «TMR0»


bcf
STATUS,RP0

; Выбор нулевого банка регистров ПД


movlw
0xFA


; Предустановка таймера/счётчика «TMR0»


movwf
TMR0

; числом 0xFA


bsf
INTCON,INTE
; Разрешение внешнего прерывания по «INT»




bsf
INTCON,RBIE
; Разрешение прерывания от линий








; порта «B» (RB4–RB7)


bsf
INTCON,T0IE
; Разрешение прерывания от «TMR0»


bsf
INTCON,GIE
; Разрешение системы прерываний

; Смена страницы памяти программ и зацикливание.



bsf
PCLATH,3



goto
LBL_1



org
0x0900      ;Установка следующей команды по адресу 0x0900 в ПП
LBL_1



incf
N, F 

; Инкрементирование содержимого регистра «N»


goto
LBL_1
; Зацикливание на операции инкрементирования


end


; Конец программы


Программа 7 «Перемножение двух 8-разрядных чисел».
Программа иллюстрирует один из способов перемножения двух 8-разрядных двоичных чисел с получением 16-разрядного произведения. В программе осуществляется загрузка множителя и множимого, затем вызывается подпрограмма их перемножающая. Произведение содержится в двух байтах памяти данных. 
;****
Программа 7*************


list p=16f877

; Определение типа МК

include <p16f877.inc>
; Подключение файла-заголовка
mulcnd
equ
0x20
; Константа «множимое»
mulplr
equ
0x21
; Константа «множитель»
rez_hi

equ
0x22
; Константа «старший байт произведения»
rez_lo

equ
0x23
; Константа «младший байт произведения»
count

equ
0x24
; Константа для организации счётчика проходов

org
0x0000
; Установить начало программы в вектор сброса
reset
goto main

; Переход на начало программы


org 0x0005

; Установка следующей команды по адресу 0x0005 в ПП
;********************************************************************


; Подпрограмма перемножения двух 8-разрядных чисел

mpy

clrf
rez_hi


; Очистка старшего и 

clrf
rez_lo


; младшего байтов произведения

movlw
0x08

; Загрузка счётчика проходов 

movwf
count

; числом 0x08 (на 8 проходов)

movf
mulcnd,W

;


bcf
STATUS,C

; Очистка флага переноса/заёма
loop

rrf
mulplr,F

; Циклический сдвиг вправо делителя и

btfsc
STATUS,C

; проверка флага переноса/заёма

addwf rez_hi,F
; mulcnd + rez_hi –> rez_hi (был перенос из старшего разряда)


rrf
rez_hi,F

; Циклический сдвиг вправо содержимого старшего и

rrf
rez_lo,F

; младшего байта произведения

decfsz   count,F

; Обратный отсчёт числа проходов

goto
loop


; Ещё проход (цикл)

retlw
0x00


; Возврат из подпрограммы с загрузкой числа 0x00 в 





; аккумулятор «WREG»
;*********************************************************************


; Основная программа

main

movlw
0x2A

; Загрузка

movwf
mulplr
; множителя (mulplr=0x2A)


movlw
0xf3

; Загрузка

movwf
mulcnd
; множимого (mulcnd=0xf3)


call
mpy


; Вызов подпрограммы перемножения


goto
$


; Зацикливание на месте

end

; Конец программы


Программа 8 «Деление двух 8-разрядных чисел».
Программа иллюстрирует один из способов деления двух 8-разрядных двоичных чисел с получением 8-разрядных частного и остатка от деления. В программе осуществляется загрузка делимого, делителя, затем вызывается подпрограмма деления. Частное от деления будет находиться в регистре «divnd», а остаток в регистре «REMB0».
;****
Программа 8************


list p=16f877

; Определение типа МК

include <p16f877.inc>
; Подключение файла-заголовка
divnd

equ
0x20

; Константа "делимое/частное"

divdr

equ
0x22

; Константа "делитель"

REMB0
equ
0x24

; Константа "остаток от деления"

LOOPCNT equ
0x27

; Константа для организации счётчика проходов



org
0x0000
; Установка адреса программы в памяти программ
RESET



goto MAIN

; Переход на начало программы



org 0x0005
; Установка следующей команды по адресу 0x0005 в ПП
;*********************************************************************


; Подпрограмма деления двух 8-разрядных чисел
UDIV


clrf
REMB0

; Очистка регистра остатка от деления


movlw
0x08

; Загрузка счётчика проходов


movwf
LOOPCNT
; числом 0x08 (на 8 проходов)
LOOP


rlf
divnd,W
; Циклический сдвиг влево делимого


rlf
REMB0, F
; Циклический сдвиг влево остатка от деления


movf
  divdr,W
; Загрузка делителя в аккумулятор с последующим


subwf  REMB0, F
; вычитанием его из остатка (REMB0 – divdr)


btfsc
STATUS,C
; Проверка флага переноса (C=1 при REMB0 > divdr)
  

goto
LBL

; Выполнить переход, если остаток > делителя


addwf  REMB0, F
; иначе, остаток восстанавливается (REMB0 + divdr)
 

bcf
STATUS,C
; Очистка флага переноса

LBL


rlf
divnd,F
; Циклический сдвиг влево делимого с сохранением 





; результатов в «divnd» (формирование частного)


decfsz   LOOPCNT, F
; Обратный отсчёт числа проходов


goto
LOOP
; Ещё проход


retlw
0x00

; Возврат из подпрограммы с загрузкой числа 0x00 в 





; аккумулятор «WREG»
;**********************************************************************


; Основная программа

MAIN



movlw
0x7f

; Загрузка 



movwf
divnd

; 
делимого



movlw
0x05

; Загрузка 



movwf
divdr

; 
делителя



call
UDIV


; Вызов подпрограммы деления «UDIV»


goto
$


; Зацикливание на месте


end

; Конец программы

3 Среда C2C-plus IDE

3.1 Описание среды C2C-plus IDE

C2C-plus IDE представляет собой отдельную интегрированную среду проектирования, объединяющую в себе текстовый редактор для создания исходного текста программы, средства ведения проекта для создания проектов из нескольких исходных файлов и подключения библиотек, транс-компилятор «C2C-plus» версии 3.28.03e для получения файлов ассемблерного кода программы из одного и более файлов с «С»-кодом программы, а также средства, обеспечивающие связь среды с внешними средствами: ассемблером MPASM, программатором и отладчиком.
3.1.1 Графический интерфейс C2C-plus IDE. Как и MPLAB IDE C2C-plus IDE имеет графический интерфейс, представленный на рисунке 3.1, 

где: 1 – главное текстовое меню, 2 – графическое меню, 4 – рабочая область, в которой размещаются открытые окна 3 с файлами, диалогами или другой информацией, 5 – строка состояния, отображающая тип выбранного МК и число строк в файле с кодом программы.
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3.1.2 Настройка среды C2C-plus IDE.[image: image33.png]& MPLAB 1DE v7.10 3
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Для начала нужно выбрать тип МК, для которого будет создаваться программа. Это делается через пункт меню Project>Target…, в появившемся окне «Target» (смотреть рисунок 3.2) из разворачивающегося списка выбирается нужный тип МК (например, PIC16F877).


Выбранный тип МК отобразится в строке состояния.

Непосредственно настройки среды производятся через пункты меню Options.
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Через пункт меню Options>Options… вызывается окно общих настроек «Options» (смотреть рисунок 3.3).


В строке «Assembler:» размещается полный путь к внешнему ассемблеру и параметры ассемблирования для него. В строке «Programmer:» указывается программа-драйвер устройства программирования. В строке «Simulator:» указывается имя отладчика.

Через пункт меню Options>Compile options… вызывается окно настроек компиляции «Compile options» (смотреть рисунок 3.4).[image: image35.png]& MPLAB 1DE v7.10 E (ol x|
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Здесь, в строке «Include:», указывается имя файла заголовка и полный путь к нему. В строке «Variable table start:» указывается адрес размещения таблицы переменных в памяти данных МК. Далее по порядку на выбор (да или нет) предлагается:


- вставлять по умолчанию подпрограмму обработки прерываний;


- единое пространство локальных переменных;


- вставлять исходный текст в файл ассемблера;


- сохранять контекст при обработке прерываний.
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Через пункт меню Options>Optimizations… вызывается окно настроек оптимизаций «Optimizations» (смотреть рисунок 3.5). Здесь предлагается выбор (да или нет):

- встроенные операции *, / , % (не функции);


- генерировать код только для вызываемых функций.

Также выбирается уровень расширенной оптимизации:


- без расширенной оптимизации;


- первый уровень расширенной оптимизации;


- второй уровень расширенной оптимизации. 
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Через пункт меню Options>Build options… вызывается окно настроек пункта меню  Compile>Build «Build options» (смотреть рисунок 3.6).
Здесь можно включить или исключить следующие этапы операции «Build»: «Compile» – компилирование) , «Assemble» – ассемблирование и «Program» – программирование.

[image: image38.png]DE v7.10 EETE

Fle Edi Vew Project Debugger Progammer Took Configwe Window Help
DS |4 ™mE 5492 | 5wEBw | Cheksum Oxbif oo B PR
=10l x|

fmouipu Project wizard

bud | Ve

Step Four
‘Add any eisingfles o you prject

<8

RECE|

PIBFGTAING

PIBEGT4INC

PIBFGTAAING

PIRGTE N
TEFRTEAINC

C\Program Files\MicrochiphMPA!

=
PIGFGTTAIN
PIFGRINC
PIBFSIIING
FIBFII4ING KT —
PIGFFIBING _';I Check the box to copy the fle o the
2 project directory

cHon [

[CEE Picierar  peo W fde [~ [ enko [

Ainyod (2 B4 [ rotel Commander .0...| ) Doca.doc - iosoft .. | 6] pLABT10um.coc - . [T MPLAB T0E v7.10 |wy 029





Через пункт меню Options>Default libraries… вызывается окно выбора библиотек по умолчанию «Default libraries» (смотреть рисунок 3.7). Здесь в пронумерованных строках указываются имена файлов подключаемых библиотек (если они используются) с указанием полного пути к ним.

На этом настройка среды заканчивается и можно приступать к созданию нового проекта, однако прежде имеет смысл  ознакомиться с некоторыми инструкциями компилятора C2C-plus и синтаксисом основных функций простейшего «C».


3.2 Язык «C» для компилятора C2C-plus

3.2.1 Переменные.
Поддерживаются 8-ми и 16-битные переменные. Они могут быть определены как глобальные или локальные (определяются в функциях). Переменная, определённая как константа, будет сохранена в памяти программ.

Пример:


char x;
//8-битная переменная;


short y;
//16-битная переменная, тоже, что и int y и long y.

 Переменная может быть помещена по физическому адресу, заданному пользователем. Для этого, после имени переменной добавляется знак «@» и указывается соответствующий адрес.

Пример:

сhar x @0x09;   //Переменная «x» будет помещена по адресу 0x09 в памяти данных.

3.2.2 Выражения. Компилятор поддерживает множество символов, операторов и директив языка программирования «С»:


- if, else, while, for, return, break, continue, extern, switch, case, default; 


- goto и метки; 


- char, short, int, long (16-битные и 8-битные беззнаковые числа), void; 


- ~, ++, --, +, -, <, <=, >, >=, ==, !=, =, !, &, |, ^,&=, |=, ^=,  &&, ||, *, /, %, <<, >>, <<=, >>=; 

Восьмибитные выражения, могут быть сложными.

Пример:
~b * 4 <= 8 != c++ - fun(5) / 2
Шестнадцатибитные выражения обычно включают в себя только два операнда.

Пример:
a16 + b16,
или 
a16 & b16++.
Для сложных выражений требуется создание временных переменных.

Поддерживаемые операции умножения (*), деления (/) и деление по модулю (%) могут быть реализованы непосредственно в коде программы или определены как функции.


3.2.3 Функции. Функция определяется в следующем виде:

char fun1(char а)
{

…

}

где
fun1 – имя функции;
char а – входной параметр типа char. 

Перед именем указывается тип возвращаемого параметра (char в данном случае). Между двумя фигурными скобками располагается тело функции (инструкции).
Функции могут возвращать результаты типов: void,  char, short, int или long.

Входные параметры их могут быть типов: void, const char*, char, short, int или long. 

Пример:
char fun1(char p1, short p2, char p3); 


Если тип возвращаемого результата и входного параметра не задан, то по умолчанию принимается char и void соответственно.
Пример:
fun(char a);
//то же, что и 
char fun( char a );



fun();

//то же, что и 
char fun( void );
 Для размещения функции по заданному адресу, после имени функции необходимо вставить знак «@» и указать нужный адрес.

Пример:


void fun( void ) @ 0x200 //Код этой функции будет начинаться с адреса 0x200
 
3.2.4 Специальные функции. Есть две специальных функции: main – для инициализации программы и interrupt – для обслуживания прерываний.

Функция main определяется следующим образом:
void main( void )


Она вызывается после инициализации глобальных переменных.
Код функции main изолирован от кода функции interrupt временными переменными.


Функция interrupt определяется следующим образом:

void interrupt( void )
Теперь, когда более понятно, о чём идёт речь можно перейти к созданию проекта с файлом на языке «С».


3.3 Создание и компилирование проекта
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Для создания нового проекта необходимо выбрать пункт командного меню Project>New Project…, в появившемся окне выбрать или создать нужную директорию, указать имя проекта, например «proba» и нажать кнопку «Открыть». 
В появившемся окне «Project» (смотреть рисунок 3.8) кнопками «Add…» и «Remove…» можно включить в список входящих файлов проекта «Input files:» ранее созданные файлы (lib-, asm-, с-файлы) или удалить их соответственно. В строке «Output file:» прописано имя выходного файла. Также в этом окне в поле «Output file type» необходимо выбрать тип выходного файла: файл ассемблера (Assembler) или библиотечный файл (Libray).

Если исходных файлов ещё нет, то список входящих файлов можно оставить пустым. Однако, после создания исходных файлов после создания проекта, их необходимо будет включить в вышеуказанный список, вновь вызвав окно «Project» через пункт меню Project>Edit Project….

Для подтверждения сделанного выбора нужно нажать кнопку «OK», окно закроется – проект готов.


Для открытия уже созданного проекта, в последующем, следует воспользоваться пунктом Project>Open Project….


3.3.1 Создание файла с исходным текстом программы.
Для создания нового файла необходимо выбрать пункт меню File>New или кликнуть на соответствующей кнопке графического меню, на рабочем столе среды появится окно текстового редактора с чистым полем, в котором с «нуля» вводится исходный текст программы с соблюдением всех правил, предъявляемых компилятором.


В качестве примера введём текст нижеприведённой программы перемножения двух восьмиразрядных чисел.

//Программа перемножения двух восьмиразрядных чисел.

char
a @0x20, b @0x21; //Инициализация глобальных переменных:

long
c @0x22;
            // "a" и "b"– две 8-разрядные, "c"– 16-разрядная переменная
void main(void)

  // Основная программа
{


a=25;


//Переменной "a" присваивается значение 25


b=50;


//Переменной "b" присваивается значение 50


c=a*b;

//Произведение; 25*50

}

   // Конец программы.

      В программе, переменные «a», «b» и «c» находятся по адресам 0x20, 0x21 и 0x22 соответственно. В переменной «с» размещается результат произведения «a» и «b»

Из приведенного листинга программы можно усвоить некоторые правила написания программ на языке «С»:


- текстовым и другим комментариям предшествует знак «//».


- начало и конец кода любой функции определяются знаками фигурных скобок «{» и «}» соответственно.


- для вызова функции в программе необходимо указать её имя и входные и выходные параметры, если таковые имеются.


После введения текста исходной программы файл нужно сохранить через пункт меню File>Save или File>Save As… под текущим или новым именем (proba.c в нашем случае) и включить в проект, как описано в пункте 3.3 «Создание нового проекта». После этого проект можно компилировать и ассемблировать. Для этого нужно выбрать пункт меню Compile>Build или Compile>Compile и Compile>Assemble для компилирования и ассемблирования результатов компиляции соответственно.


В случае успешной компиляции будет создан файл ассемблера «proba.asm».
В случае успешного ассемблирования ассемблером будут созданы все соответствующие файлы, включая файл с шестнадцатеричным кодом программы, а в рабочей области среды раскроется окно с содержимым файла листинга. Оба случая будут сопровождаться сообщениями об отсутствии ошибок. Так в нашем случае после компилирования автоматически был создан файл «proba.asm» ассемблерным кодом программы перемножения двух восьмиразрядных чисел. Ниже приведено содержимое файла «proba.asm» с комментариями через знак «;».

; This file was generated by C2C-plus compiler version 3.28.03e


include "C:\Program Files\C2C\Include\P16F877.INC"


;Variables *****************************************

_code_tmp_0000

equ 0x70
; Инициализация переменных
__md__tmp0

equ 0x71
;   для временного 
__md__tmp1

equ 0x72
;     хранения
__md__tmp2

equ 0x73
;       данных
_a



equ 0x20
; Переменная «множимое»
_b



equ 0x21
; Переменная «множитель»
_c



equ 0x22
; Переменная «произведение»

ORG 0



; Установка начала программы в вектор сброса

clrf PCLATH


; Очистка старшего байта счётчика команд

goto start__code

; Переход на start__code (начало)
__mul8


; Подпрограмма перемножения двух 8-разрядных чисел

goto __mul8__code
; Переход к последующим инструкциям подпрограммы
start__code
_main__code

; Начало основной программы

movlw D'25'

; Загрузка числа 25 в регистр WREG

bcf STATUS, RP0

; Выбор

bcf STATUS, RP1

;   банка «0»


movwf _a


; Загрузка множимого

movlw D'50'

; Загрузка

movwf _b


;   множителя

movf _a, W


; Перенос множимого в

movwf __md__tmp0
;   регистр временного хранения

movf _b, W


; Перенос множителя в

movwf __md__tmp1
;   регистр временного хранения

call __mul8


; Вызов подпрограммы перемножения двух чисел

bcf PCLATH, 3

; Выбор страницы «0»


bcf PCLATH, 4

;   в памяти программ

movwf _code_tmp_0000  ; Старший байт произведения –> _code_tmp_0000  

movf __md__tmp1, W
; Младший байт произведения –> WREG

bcf STATUS, RP0

; Выбор

bcf STATUS, RP1

;   банка «0»

movwf _c

        ; Загрузка младшего байта произведения в регистр «_c»

movf _code_tmp_0000 , W
; Загрузка старшего байта произведения

movwf _c+D'1'


;    в регистр «_c» по адресу 0x22+0x01=0x23

_main__end


; Окончание основной программы
__mul8__code
; Инструкции подпрограммы перемножения 8-разрядных чисел

movlw D'9'


; Инициализация обратного счётчика

movwf __md__tmp2
;   проходов числом 9

movf __md__tmp0, W
; Перенос множимого в WREG

clrf __md__tmp0

; Инициализация временного регистра множимого

bcf STATUS, C

; Очистка флага переноса C
label_0000


rrf __md__tmp0, F
; Циклический сдвиг вправо рабочих регистров

rrf __md__tmp1, F
; множимого и множителя соответственно

btfsc STATUS, C

; Проверка флага переноса C, C=1–был перенос

addwf __md__tmp0, F
; произведение + множимое ,если C=1


decfsz __md__tmp2, F
; Уменьшить счётчик проходов на 1

goto label_0000

; Повторить проход, если счётчик не обнулился

movf __md__tmp0, W
; Перенос старшего байта произведения в WREG

return

; Возврат из подпрограммы перемножения
__mul8__end

END

; Конец программы
Список использованных источников
1 Предко М. Руководство по микроконтроллерам. Том II. Москва: Постмаркет, 2001. – 488с.

2 Яценков В.С. Микроконтроллеры MICROCHIP. Практическое руководство. Москва: Горячая линия – Телеком, 2002. –  296с.
 3 Программирование на языке C  для AVR и PIC микроконтроллеров./ Сост. Ю.А. Шпак – К.: «МК-Пресс», 2006.– 400 с., ил.
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Рисунок 3.8 – Окно «Project».





Рисунок 3.7 – Окно «Default libraries».





Рисунок 3.6 – Окно «Build options».





Рисунок 3.5 – Окно «Optimizations».





Рисунок 3.4 – Окно «Compile options».





Рисунок 3.3 – Окно «Options».





Рисунок 3.2 – Окно «Target».





Рисунок 3.1 – Графический интерфейс рабочего стола среды C2C-plus IDE.
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Рисунок 2.15 – диалоговое окно «Stimulus Controller».





Рисунок 3.14 – Окно системного секундомера «Stopwatch».





Рисунок 2.13 – Окно задания точек останова «Breakpoints».





Рисунок 2.12 – Окно свойств и настроек для «Watch».





Рисунок 2.11 – Окно с переменными «Watch» и его системное меню справа.





Рисунок 2.10 б – Окно с сообщениями компилятора, полученное после неудачной компиляции проекта (в проекте имеются ошибки).





Рисунок 2.10 а – Окно с сообщениями компилятора, полученное после успешной компиляции проекта (в проекте отсутствуют ошибки).





а)					б)						с)


Рисунок 2.9 – Создание и добавление файлов-источников в текущий проект.





		а)								б)


Рисунок 2.8 – Окно настройки параметров программного отладчика «Simulator Settings»:  а) – раскладка «Osc/Trace»;  б) – раскладка «Break Options».





Рисунок 2.7 – Окно установки битов конфигурации «Configuration Bits».





Рисунок 2.6 – Окно выбора типа микроконтроллера «Select Device».





Рисунок 2.5 – Окно четвёртого шага «Add any existing files to your project».





Рисунок 2.4 – Окно третьего шага «Name your project».





Рисунок 2.3 – Окно второго шага «Select a language toolsuite».





Рисунок 2.2 – Окно первого шага «Select a device».
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Рисунок 2.1 – Графический интерфейс рабочего стола среды MPLAB IDE.








[image: image40.png][ MPLAB IDE v7.10 =101 x|
Fle Edi Vew Project Debugger Progammer Took Configwe Window Help
DS |4 ™mE 5492 | 5wEBw | Cheksum Oxbif oo B PR

e —

o |

Step Two:
Select 3 language toolsuite

Active Toalsuit:

[~ Toolsute Conterts

MPLINK Dbject Lirker (mplink exe)
MPLIB Librarian (mpl eve)

- Location
[C:\Program Files\MicrochipMPASM Sute\WPAsTWin exe

=

Helpl My Suie srit Listed! I~ Show al nstaled tookuites

Orvera

| =z

[CEE Picierar  peo W fde [

Ainyod (2 B4 [ rotel Commander .0...| ) Doca.doc - iosoft .. | 6] pLABT10um.coc - . [T MPLAB T0E v7.10 |wy o0z

[ fpenko |




[image: image41.png]|\ MPLAB IDE v7.10 = =10l x|

File Edt View Project Debugger Frogrammer Tools Corfigure Window _Help
TN o Do me eI
0 o b o> H P FE

Step One:
Select a device

oz || (o

[CEE Picierar  peo W fde [~ [ enko [

Ainyod (2 B4 [ rotel Commander .0...| ) Doca.doc - iosoft .. | 6] pLABT10um.coc - . [T MPLAB T0E v7.10 .04923 st




[image: image42.png]am MPLAB IDE v6.62 =18 x|
File Edt View Project Debugger Progiammer Tools Corfigure Window Help

] Diﬂ\%\ﬂ\éﬂ?ﬂ '@ H B | S e | Checksum: 0x505c | o oo B O B
;IEI—I

E proba.mcp “PLeFe77.ine-
5 Sourcs Files
proba.asm
Header Files
Object Fies
Library Fies
Linker Sciits
Other Files

Frogram Mermory Breakpoints:

E ot proba.asm. 14 Bemave

Remove Al

Ensble Al

Disable All

Active Breakpornt Linit  Avaibl Breakpoints:

T = R
Cancel Help.

AddSER| [EDCOND +] | Add Symbal

Symbol [y

o1

MPLAB S | [Pcierer7 ped [WiBe  [adeo = [bark0 [n6.CalT IS |

AAnyex ||| 4] <2 6 1 & B @ || Sinposcr | Bjoowc...| Savpdoc | Padobe . |[BjMpL_ Zyeue.| [BIGE 1319




[image: image43.png][\ MPLAB IDE v7.10.

Fle i e prorec

= probamep
£ Source Files E—
e Size: [ Bbts

5 Header Files
prereranc | Fomet[Hen E

ObjctFles
s |
ke st

Ot s Moy [P

| By Progeries | Pofrences | Gener]

21|

~=lolx|

lecksum: 0x5058

[vuwe e
_iojx]

e =

Waich1 | Watch2| Watch3| Watch4

eLags | Picierar  peo W

Binye| (2 B [ Total Commend...| B PLaB710m.d...| B Doc2.doc - Micr.. | ) Aokymens - . |"wmmn . @ vz

penko | R




[image: image44.png]Ainyod (@ B [ Total Commander




[image: image45.png]|\ MPLAB IDE v7.10
Fie Edt llow Propct Dobuger Programmer Toos Configure Window e

DS |4 ™mE 5492 | 5wEBw | Cheksum Oxbif
[m untited viork =lojx|

=101x|

Device:

PICIEFE77

- Microchip Programmer Tool Support
@ PICSTART Plus @ WPLABICD 2
@ FROMATENl @ Fickit1

@ WPLAB PM3

5ud_| Versin

- Microchip Debugger Tosl Support
@ WPLAB SIM @ WPLABICD 2

MPLAB ICE 2000
POMIBKKD
@rcmiexkt

MPLAB ICE 4000
No Madule.

I [ picisra | w0 f&e [ [ pako | = 4
Bnye| (2 B 1 Totel Command...| ) weLag710um.d... | B) main.doc - ... | 5 agevyLngvo




[image: image46.png]| MPLAB IDE v7.10 =101

b o> H P FE

[ Configuration Bits




[image: image47.png]=181x]

- x

~=lolx|

Fie Edt Project Comple Options Widon Fep
R EEEEEE]

Ci\Program Files\C2C\user\HoBan nanka\probs =lolx|

#/1f necessary insert your global variables declaration hers

C:\Program Files\C2C\user\Hopan nankalprobasis
include C:\Progran Files\C2C\Include\PL6F877. INC"
T PN e N R N
/TURD Overt
_int_save cone 7 S D70
void THRO_ta: __int_save_cont_STATUS equ 0x71
{ __int_save_cont_FSR equ 0x72
T ntTSave cone_PCIaTH = 073
4 ORG 0
Clrf BCLATH
I— Goto start, _code

C:\Program Files\C2C\user\HoBas nanka\proba.c
Optimized 13 instruction

No errorg|

PIC1eFa77

cmot Pmat 11 Hat3m CT 4 Kon 17

Binye| (2 [ P Total Commander 6.01 -

340 WCTP BAT 340 pyconii(Po O

Microsoft Word -|[% czcpus 10E B 1512




[image: image48.png]=181x]

[pseks B Goraeca Dopuar Cepenc Tabnas Oueo Crpsses Er— - x
D@ e lm o o o i =
C2CIDE_proba.C2C —{o x|
4 O6b Fie Edit Project Comple Options Window Help -
AlBls] @lclal2|
Project
Input e
Ouput e
¥ Progran Fies\C2Eworkpcbacba ASH
- Outut e pe
& Assembler © Library
Ficiererr | °

2 Hazgm cr2 Kon

.2

nyod (2 B4 1 Totel Command...| ) cocphs.coc-

Paa 1

1 SAMN MCTP BAN 34N pycekni (Po
| B1czc aoxprnr.. | Besora ccac

ox

[[% czc o prob.. E[@ e 1616




[image: image49.png]otal Commander 6.01 - NOT REGISTERED =2 x|
Soin Besereme Konoin Cors ona. Kowdrypoun Mk e
Fo [0 9d e 91 o B .| Fa (o0 od He Gt Ho gy [\[]

master]_ [ T —oix|

L Fle Edt proect Comple Optins_Window _He =lsx|
al8|m| &lclal

=
//Interrupt processing
//THRD Overflow processing
if( INTCON & 4 )

i
clear_bit( INTCON, 2 ):

taskl():
) O
e
PHIEESS =
: T e pom 2l [
s e |
i
%58 poxe Change

if( INTCON & 1)
i

clear_bit( INTCON. 0 ):
task3():

7/Insert your code which should run
s/after any interrupt processing here

b

//This is the main function vhich is called =

i Ficiere

0 KB m3 11 635 Kb. gpannos: 0 n3 31 0 KB 13 55 589 Kb. pannos: 0 u3 16

@inye| (2 [ 3 Total Commander 6.01 - .. | B aCps.doc - Micosoft .. [[ G C2C-plus 10E - [probal B 2349




[image: image50.png]2 C2Cplus.doc - Microsoft Word

DEHAE SGRY 3.
4 oo, CEETITI

ndow_Felp

¥ Insett defaulinerrupt handler
r ariabl

 saving duting nferupt

cmot Pmat

Ainyee| (2 B [ Total Commander




[image: image51.png]=] =181]

Ha e cd Se S S0 Sy Ua [ cad ©e ©F Sa By [y

Imaster] 0 gl
¥l

2 inine operations .

7 code orly for called unctons:

Extended opinization
" No estended optimization
" Level 1 estended optinization

& Level 2 evtended optinization

PIC1eFa4

0 KB u3 55 Kb. qpannos: 0 us 7 0 KB 13 44 209 Kb, annos: 0 u3 43
@inye| (2 1 1 Totol Command...| 8] c2C aoxywen... | ) cacplus doc - ... |[G Coc-plusDE &) Getting started.. | [ [@ ¢ 21146




[image: image52.png]Dpaeca Bna Boraska Oopwer Cepevc  Tabmmia

6l Fie gt Project Complle Options Window _Help

=181x]

- x

oo Crpaska Boeae sonpoc

~=lolx|

P DI8[8] [c|al e

piciorat

«

cm. 1

Paa 1 11 Ha257m CT18 Kot

nyod (2 B4 1 rote Command...| 8] c2€ aoxymen... | ) cocphs.coc-

SATVCTP BAT 3N sk G

[ cocplusoE &) Getting started.. | @& 2156




[image: image53.png]=181x]

Boeae sonpoc - x

~=lolx|

©ain [paca Baa Brraska Gopwar Cepoc Dsbmus Oeio Crpasca

C2C-plus IDE
6l Fie gt Project Complle Options Window _Help

alfs|ic) C|al:

Assembler. [\CZC\MPASHWIN EXE /aINHXEM /o165

Programmer [picprog eve

S

IV Alermais

O - —
= Dot

PIC1eFa77

“ond

I
3

il

cm2  Pmat 26 Hailim Cr6 Kenl AT UCTP BAT 3 asrmecced

inyod (2 B4 [ rote Commander 6.0...| 2] paora cCoC.doc - . | ) cocphsdoc - iro... [ C2C-plus 1O B@& oo




[image: image54.png]izl C2Cplus.doc - Microsoft Word
in Doaera > 8 Crpaera

D & o ———

4 oo e e

¥ Compi

BT il

cmot Pmat

Ainyod (@ B [ Total Commande:




